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Ders  13 � Kullanõşlõ Çizim Araçlarõ

Ders 13�te daha önce değinmediğimiz bazõ çizim araçlarõnõn kullanõmõnõ gündeme getireceğiz.

Ölçü Çizgilerini Birleştirmek

Ölçü Noktasõ Eklemek veya Kaldõrmak

Kot Markasõ

Kaynak İşareti

Ölçülendirme Şeçenekleri

  Kaydet, Farklõ Kaydet, Yükle

  Doğrudan

  Açõ Tipi

  Hassasiyet

  Biçim

  Yazõ Rengi

Dikine Çizgiler

Çok Satõrlõ Yazõ

Semboller Girmek

Parça Markalarõ Oluşturmak
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Çizim Görünüşlerini Kopyalamak ve Birleştirmek

   Çizim Görünüşlerinin Kopyalanmasõ

   Çizim Görünüşlerinin Birleştirilmesi

   Çizim Görünüşlerinin Plan Üzerine Kopyalanmasõ

   Çizim Görünüşlerinin Plan Üzerine Birleştirilmesi

Görüntüyü Döndür

Markalarõn Güncellenmesi

Filtre Seç

Çizim Listesi Komutlarõ

  Aç

  Güncelle

  Markalarõ Güncelle

  İptal Et

  Görüntüle

  Filtrele

  Kilitle

  Kullanõma Aç

  Gözden Geçir
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Ölçü Çizgilerini Birleştir

Birbirine paralel iki veya daha fazla ölçüyü veya ölçü grubunu tek çizgide birleştirmek istediğinize
kullanõrsõnõz.

Ctrl tuşunu basõlõ tutarak birleştirmek istediğiniz ölçüleri seçin. İkona basõn (veya fare sağ tuşuna) ve
Combine dim lines�i seçin.

Ölçü Noktasõ Eklemek / Kaldõrmak

Mevcut ölçüyü oluşturan noktalarõn yerini değiştirmek istediğinizde kullanõrsõnõz. Değiştirmek istediğiniz
ölçüyü seçin; bir defada sadece bir ölçü değiştirebilir. Uygun kutusunu seçin (veya fare sağ tuşuna
tõklayõp ya Ad dimension point veya Remove dimension point�i seçin) değiştirmek istediğiniz noktayõ
ekleyin veya kaldõrõn.   
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Kot İşareti

Bu komut çizim içerisinde seçtiğiniz bir noktaya kot markasõ koyar.

Ekranõn sol tarafõndaki çizim menü çubuğu üzerindeki Level mark ikonuna çift tõklayõn.
Bu işlem Kot markasõ atamalarõ iletişim kutusunu açar. Buradan kot markasõnõn çizim içinde nasõl
görünmesini istediğinize dair değişiklikler yapabilirsiniz.

İstediğiniz değişkenleri ayarlayõp OK tuşuna basõn.
Çizim üzerinden kot markasõnõ tanõmlamak istediğiniz noktayõ
seçin ve markanõn görünmesini istediğiniz noktaya tõklayõn.
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 Kaynak Sembolü

Kaynak sembolü aracõ, çiziminiz üzerine görmek istediğiniz kaynak sembollerini ekler.

İletişim kutusunu açmak için Create weld symbol  ikonuna çift tõklayõn.

İstediğiniz kaynak tipini belirlemek için Type aşağõ
açõlõr menüsünü açõn. Sembol için ihtiyaç
duyacağõnõz diğer gerekli bilgileri girin.
Reference text kutusu istediğiniz notu kaynağõn
ucuna (kuyruğuna) eklemenizi sağlar. İşiniz bitince
OK� e basõn.

Çizim üzerinde kaynağõn uygulanmasõnõ
istediğiniz noktayõ ve sembolün yerleştirilmesini
istediğiniz noktayõ seçin. Create weld symbol
aynõ zamanda mevcut bir kaynak sembolünün
değiştirilmesinde de kullanõlabilir.
(Fakat modelde görülen kaynaklarõn değil.)
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Ölçü Seçenekleri

Dimension komutu seçilen iki nokta arasõna ölçü koyar. Snap anahtarlarõ hangi noktalarõn seçileceğini
kontrol etmekte kullanõlõr.

Ölçü özellikleri Dimension Properties iletişim
kutusundan ayarlanõr. İletişim kutusunu açmak
için ölçü kutularõndan birinin üstüne çift tõklayõn.

Kaydet, Farklõ Kaydet, Yükle
Farklõ seçeneklerde sunulan değerleri
ihtiyaçlarõnõza göre ayarladõktan sonra bu
ayarlarõ standard olarak Save (Kayõt) edin.

Özel bir proje için standart ayarlar üzerinde
değişiklik yapma ihtiyacõ isteyebilirsiniz. Önceden
tanõmlõ değerleri değiştirmek için üzerlerinde
değişiklikler yapõp Save as komutunu kullanarak
bu değişiklikleri özel bir ad altõnda kaydedin.
Aşağõ açõlõr menüden kaydedilmiş önceden
tanõmlõ değerleri seçip Load dediğinizde değerler
önceden tanõmlõ değerlere geri döner.
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Doğrudan

Aşağõ açõlõr menüden bir ölçü stili seçin.

Dikkat: Ara ölçüler her zaman mutlak ölçülerdir.

Relatif Mutlak

Relatif ve mutlak
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Açõ Türü :

Angle type görüntülenecek açõ ölçüm tipini tanõmlar

Hassasiyet:

Precision görüntülenen ölçü üzerindeki sayõnõn yuvarlama faktörünü kontrol eder.

Format:

Format ölçü numarasõnõn hangi biçimde görüntüleneceğini belirler. Parantez içinde gösterilen sayõsal
seçime bağlõdõr ve sadece gerektiğinde gösterilir. Örneğin; biçim ###.[#] şeklinde seçildi ise 100.0 sayõsõ
100 olarak yazõlõr ve eğer biçim ###.# şeklinde seçildi ise bu sayõ 100.0 olarak yazõlõr.
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Metin  Rengi:

Bu renkler çizim içindeki çizgi kalõnlõklarõnõ kontrol eder.

Çizgi kalõnlõklarõ ile ilgili daha fazla bilgi almak için Contents->Modeling->File->Database->Plotters-
>Modify...(On NT) altõndaki Coloor table ve Pen number ile ilgili yardõm dosyalarõnõ okuyun.
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Dikey Çizgiler

Ortho komutu çizgi komutuyla beraber kullanõldõğõnda seçilen bir başlangõç noktasõndan itibaren 45
derecelik basamaklarla doğrusal çizgiler çizmeye yarar.

Ortho�yu aktif hale getirmek için çizgi komutuyla başlayõp ister yakalama ayarlarõ araç çubuğunu
kullanarak ister klavye üzerindeki O tuşuna basarak bir başlangõç noktasõ seçin.

Dikkat: Yakalama ayarlarõ araç çubuklarõnõn kullanõmõ ile ilgili daha fazla bilgi edinmek için Drawings-
>Setup->Entering/locking coordinates zinciri altõnda bulunan yardõm dosyalarõndaki alõştõrmalarõ
okuyun ve uygulayõn.
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Çok Satõrlõ Yazõ

Menüden Pick Create->Text->Text [multi] zincirini izleyip yazõ için bir başlangõç noktasõ seçin. Yazõ
satõrõnõ yazõn ve sonra ya create�õ tõklayõn veya yeni bir yazõ satõrõna başlamak için enter tuşuna basõn.
Her satõr soldan başlayarak ve bir önceki satõrla aynõ çizgiden başlayarak yazõlõr.
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Sembolleri Girmek

Symbol kutusuna  çift tõklayõn.
Select tuşuna basõn ve önceden tanõmlõ sembollerden seçin.
Apply tuşuna veya OK tuşuna basõn.
Symbol kutusuna bir kez tõklayõn ve sembolün yerini belirlemek için çizim üzerinde bir yere tõklayõn.
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Kõsmi Parça Markalarõ

Parça markalarõ �Part mark properties� (parça marka özellikleri) iletişim kutusundan ayarlanõr.

Herhangi bir asamble çizimini açõn.
Geri plandaki çizime sağ tuşla tõklayõn.
Asamble çizim özellikleri iletişim kutusundan Part mark... tuşuna tõklayõn.

Part mark properties (Parça marka özellikleri) iletişim kutusundan hangi parçalarõn markalanmasõ
gerektiğini ve markalarõn nasõl görüneceğini ayarlayabilirsiniz.
Mevcut bir marka da part mark iletişim kutusundan değiştirilebilir.

Değişikliklerinizi yapõp Modify tuşuna tõklayõn.

Dikkat: Markalanmamõş bir parçayõ markalamak için parçayõ seçip sağ tuşla tõklayõn ve Part mark�õ
seçin.
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Çizim Görünüşlerinin Kopyalanmasõ ve Birleştirme

Bu ve buna ilişkin komutlar (plana bağlõ görünüş çizimi kopyalama, plana bağlõ görünüş çizimi
birleştirme) bir çizimden bir başka çizime görünüşler eklemenize olanak sağlar.

Çizim listesini açõn.(Drawing list kutusuna tõklayõn.)
Listedeki çizimlerden birini rasgele açõn.
Çizim listesinden bir başka çizimi aktif hale getirin.
Ekranõn üst kõsmõndaki çizim menüsü üzerinden Create->Copy drawing views zincirini seçin.
Kopyalanan çizimden alõnan görünüşler açõk çizim üzerinde belirir.

Copy ve linking komutlarõ arasõnda çok az farklõlõk vardõr.

   Çizim Görünüşlerinin Kopyalanmasõ:

•  Görünüşleri bir plan kullanmadan kopyalar. (başlõk bloğu, malzeme listesi v.b.)
•  Kopyalanan görünüşler model içinde yapõlan değişikliklerden etkilenmez, güncellenmez.

   Çizim Görünüşlerinin Birleştirilmesi:

•  Kopyalama (Copy) komutuna benzer şekilde �Link drawing views� (Çizim görünüşlerini birleştir)
komutu çizimleri bir plana bağlõ olmadan birleştirir.

•  Görünüşler model içinde yapõlan değişikliklerden etkilenerek güncellenir.

Plana Bağlõ Çizim Görünüşlerinin Kopyalanmasõ:

•  Adõndan da anlaşõlacağõ gibi planlar görünüşlerle birlikte gelir.
•  Model içindeki değişikliklerden etkilenir, güncellenir.

Plan Bağlõ Çizim Görünüşlerinin Birleştirilmesi:

•  Bu işlem aynõ zamanda plana bağlõ görünüşler ekler.
•  Model üzerinde yapõlan değişikliklerden etkilenir.

Dikkat: Bir Plana bağlõ olarak eklenmiş çizim görünüşlerine sahip çizimler, planõn görülebilir olmasõ için
önce kapanmalõ sonra tekrar açõlmalõdõr.
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Görünüşü Döndür

Görünüşü döndürmek için herhangi bir çizimi açõn.
Aktif hale getirmek için mavi sõnõr çizgisine tõklayõn.
Sağ tuşla tõklayõp Rotate�i seçin.(Veya menüden Edit->Rotate View�i seçin.)
Bu işlem Rotate view iletişim kutusunu açar

Angle için bir değer girin ve Rotate tuşuna basõn.
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Markalarõn Güncellenmesi

Bir model üzerinde değişiklikler yapõldõğõnda çizimlerin tekrar açõlmadan önce güncellenmesi
gerekmektedir. Eğer çizim üzerinde Freeze özelliği açõk değilse güncelleme yapõldõğõnda markalar ve
ölçüler otomatik olarak güncellenir. Eğer Freeze (Dondurmak) özelliği açõk ise çizimi güncellemek
istediğinizde onu açõp markalarõ güncellemeniz ve ölçüleri de elle oluşturmanõz gerekmektedir.

Bir çizimi açõn.
Edit->Update marks�õ seçtiğiniz zaman istediğiniz herhangi bir markayõ veya isterseniz tümünü birden
değiştirme şansõnõz vardõr.

Tüm markalarõ sağ tuşla tõklayõp Update marks�õ seçerek güncelleyebilirsiniz.

Filtre Seç

Setup->Select filter  zinciri ekran üzerinden seçilebilecek nesneleri tanõmlar. (Modelleme ortamõndan
veya çizim ortamõndan)
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Notlar:
1. Filtre zinciri ile ilgili bilgiler model içindeymiş gibi tamamen görünmelidir.(Büyük harflerle ifade

etmek, küçük harflerle ifade etmek, tam isimler v.s.)
2. bir nesnenin seçilebilmesi için model içinde görülebilir olmasõ gerekir



                                                                                                                      

Xsteel Eğitim Kursu                                                                                                           Ders 13  � Kullanõşlõ Çizim Araçlarõ

Copyright Tekla Oyj 2000,  Computers & Engineering 2002  Tel: 0049 6406 73667   www.comp-engineering.com           Sayfa 13-18

CCCOOOMMMPPPUUUTTTEEERRRSSS   &&&
EEENNNGGGIIINNNEEEEEERRRIIINNNGGG

Seçim Anahtarlarõ

Seçim anahtarlarõna ekranõn sol üst kõsmõndan ulaşõlabilir.

Herhangi bir nedenden dolayõ çizim içinde belirli bir nesneyi seçmek isteyebilirsiniz, bunun için buna
karşõlõk gelen anahtarõ seçebilirsiniz. Bu işlemden sonra sadece bu tip nesneler seçilebilir olur. Normal
ayarlamalar ise Any object tuşuna basõlarak yapõlabilir.
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Çizim Listesi Komutlarõ

Aşağõda, çizim listesindeki komutlarõn her birinin kõsa bir açõklamasõnõ bulacaksõnõz.

Açõk

Çizim listesinden herhangi bir çizimi seçip aktif hale getirin sonrada Open tuşuna basõn.

Aynõ işlemi çizim listesindeki bir çizimin üzerine çift tõklayarak da yapabilirsiniz.

Güncelle

Üzerinde �P� veya �N� bayraklarõndan birini taşõyan herhangi bir çizimi seçin ve sonra model içindeki
herhangi bir değişiklikten dolayõ gereken güncellemeyi yapmak için Update tuşuna basõn.

Markalarõ Güncelle

Listeden seçilen çizimlerin herhangi birindeki markalar tuş aracõlõğõ ile güncellenebilir.

İptal

Seçim listesinden dondurulmuş veya kilitlenmişler de dahil istediğiniz tüm çizimleri siler, kaldõrõr.
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Görüntüle (Display)

Tümünü (All)

Listelenen tüm çizimleri görüntüler.

Tersini (Invert)

Filtre edilen grubun dõşõndakileri görüntüler.

Filtreler

Seçilenler  (Selected)

Seçilen bir çizimi veya çizim gurubunu filtreleyip onlarõ çizim listesinde görülebilen yegane çizimlere
çevirir.

Güncellenmişler (Up to date)

Bu, sadece güncellenmiş çizimleri çizim listesinde görülebilir hale getirir.

Seçili Kõsõmlar (Select Parts)

Çizimleri listeden seçtikten sonra Select Parts tuşuna basarsanõz model içinde seçilenlere karşõlõk gelen
parçalar parlar.

Kõsmi (By Parts)

Model içinde nesneleri seçip By Parts tuşuna basarsanõz, seçim listesi sadece seçtiğiniz parçalar
görülecek şekilde filtrelenir.
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Kilit (Lock)

Aktif (On)

Çizimleri kilitlemenin amacõ üzerinde değişiklikler yapõlmasõnõ engellemektir. Güncelleme bayraklarõ hala
mevcut olabilir.

Kapalõ (Off)

Kilitleri kaldõrõr ve çizimler üzerinde değişiklikler yapõlabilir.

Hayata Geçirmek  (Issue)

Açõk (On)

Bu komut hayata geçirilecek çizimlerin yanõndaki bayraklar kolonuna �I� harfi koyar.

Kapalõ (Off)

Bu işlem ise çizim listesinde yanõndaki bayraklar kolonunda �I� bulunan çizimlerin I işaretlerini kaldõrõr.
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 Revizyon... (Gözden Geçirme)

Gözden geçirme işlemine ait bilgilerin eklenmesi, değiştirilmesi veya kaldõrõlmasõ işlerinin halledildiği
iletişim kutusunu açar.

Markalama

Çizimleri markalarken revizyon numaralarõnõn girilmesinde kullanõlõr.

Revizyon aşağõ açõlõr kutusu

Revizyon markasõnõn yanõndaki kutu yapõlan revizyonlarõn numaralarõnõ taşõr ve otomatik olarak
güncellenir. Her çizim kendi bağõmsõz revizyon numarasõna sahiptir.

Tarih

Revizyon tarihi otomatik değildir yazõlabilen bir yazõ alanõndan oluşur.
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Yazõ

Yapõlan revizyonlarõ ifade etmek amacõ ile üç satõrdan oluşan bir metin kullanõlabilir.

İptal

İptal tuşu aşağõ açõlõr revizyon kutusunda listelenen revizyonlar arasõndan seçilen revizyonu kaldõrõr.
Revizyon numarasõnõn iptal edilmesinden sonra aşağõ açõlõr revizyon kutusunda kalan numaralar
yeniden numaralandõrõlõr.(Revizyon markalarõ değişmez.)


